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Note to the Author

[This document is a template of a Test Plan document for a project. The template includes instructions to the author, boilerplate text, and fields that should be replaced with the values specific to the project.

· Blue italicized text enclosed in square brackets ([text]) provides instructions to the document author, or describes the intent, assumptions and context for content included in this document.

· Blue italicized text enclosed in angle brackets (<text>) indicates a field that should be replaced with information specific to a particular project.

· Text and tables in black are provided as boilerplate examples of wording and formats that may be used or modified as appropriate to a specific project.  These are offered only as suggestions to assist in developing project documents; they are not mandatory formats.

When using this template for your project document, it is recommended that you follow these steps:
1. Replace all text enclosed in angle brackets (i.e., <Project Name>) with the correct field values. These angle brackets appear in both the body of the document and in headers and footers.  To customize fields in Microsoft Word (which display a gray background when selected):
a. Select File>Properties>Summary and fill in the Title field with the Document Name and the Subject field with the Project Name.  
b. Select File>Properties>Custom and fill in the Last Modified, Status, and Version fields with the appropriate information for this document. 
c. After you click OK to close the dialog box, update the fields throughout the document with these values by selecting Edit>Select All (or Ctrl-A) and pressing F9.  Or you can update an individual field by clicking on it and pressing F9. This must be done separately for Headers and Footers.
2. Modify boilerplate text as appropriate to the specific project. 
3. To add any new sections to the document, ensure that the appropriate header and body text styles are maintained.  Styles used for the Section Headings are Heading 1, Heading 2 and Heading 3.  Style used for boilerplate text is Body Text.
4. To update the Table of Contents, right-click and select “Update field” and choose the option- “Update entire table”
5. Before submission of the first draft of this document, delete this “Notes to the Author” page and all instructions to the author, which appear throughout the document as blue italicized text enclosed in square brackets.]
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[bookmark: _Toc423902158]
Introduction
[bookmark: _Toc456598587][bookmark: _Toc456600918][bookmark: _Toc494193640][bookmark: _Toc423902159]Purpose of The Test Plan Document
[Provide the purpose of the Test Plan Document. This document should be tailored to fit a particular project’s needs.]
[bookmark: OLE_LINK1][bookmark: OLE_LINK2]The Test Plan document documents and tracks the necessary information required to effectively define the approach to be used in the testing of the project’s product. The Test Plan document is created in order to communicate test plans to all relevant parties that need to understand what and how to test.
[bookmark: _Toc494193648][bookmark: _Toc423902160]COMPATIBILITY Testing (Normally Software)
Compatibility test is a non-functional test conducted on the application to evaluate the application's compatibility within different environments.
[bookmark: _Toc423902161]Test Risks / Issues
 [Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]
[bookmark: _Toc423902162]Items to be Tested / Not Tested
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]
	Item to Test
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc423902163]Test Approach(s)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
[bookmark: _Toc423902164]Test Regulatory / Mandate Criteria
[Describe any regulations or mandates that the system must be tested against.]
[bookmark: _Toc423902165]Test Pass / Fail Criteria
[Describe the criteria used to determine if a test item has passed or failed its test.]
[bookmark: _Toc423902166]Test Entry / Exit Criteria
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]
[bookmark: _Toc423902167]Test Deliverables
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]
[bookmark: _Toc423902168]Test Suspension / Resumption Criteria
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]
[bookmark: _Toc423902169]Test Environmental / Staffing / Training Needs
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc).)]
[bookmark: _Toc423902170]Conformance Testing
Conformance testing or type testing is testing to determine whether a product or system or just a medium complies with the requirements of specification, contract or regulation. If you have a product that requires certification to show it has met the relevant country or product regulations, you need to ensure you understand what these requirements are and document them here within the test plan.
[bookmark: _Toc423902171]Test Risks / Issues
 [Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]
[bookmark: _Toc423902172]Items to be Tested / Not Tested
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]
	Item to Test
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc423902173]Test Approach(s)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
[bookmark: _Toc423902174]Test Regulatory / Mandate Criteria
[Describe any regulations or mandates that the system must be tested against.]
[bookmark: _Toc423902175]Test Pass / Fail Criteria
[Describe the criteria used to determine if a test item has passed or failed its test.]
[bookmark: _Toc423902176]Test Entry / Exit Criteria
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]
[bookmark: _Toc423902177]Test Deliverables
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]
[bookmark: _Toc423902178]Test Suspension / Resumption Criteria
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]
[bookmark: _Toc423902179]Test Environmental / Staffing / Training Needs
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc).)]
[bookmark: _Toc423902180]Functional Testing
Functional testing tests the functions of a component or system and refers to activities that verify a specific action or function of the product, process, computer program or a system element.
[bookmark: _Toc423902181]Test Risks / Issues
 [Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]
[bookmark: _Toc423902182]Items to be Tested / Not Tested
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]
	Item to Test
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc423902183]Test Approach(s)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
[bookmark: _Toc423902184]Test Regulatory / Mandate Criteria
[Describe any regulations or mandates that the system must be tested against.]
[bookmark: _Toc423902185]Test Pass / Fail Criteria
[Describe the criteria used to determine if a test item has passed or failed its test.]
[bookmark: _Toc423902186]Test Entry / Exit Criteria
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]
[bookmark: _Toc423902187]Test Deliverables
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]
[bookmark: _Toc423902188]Test Suspension / Resumption Criteria
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]
[bookmark: _Toc423902189]Test Environmental / Staffing / Training Needs
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc).)]
[bookmark: _Toc423902190]PRE-BUILD Testing
Pre-build testing involves testing critical components or sub-assemblies prior to any build or assembly process to ensure correct functionality. The sooner issues and faults are found the less cost is incurred in resolving the issues.
[bookmark: _Toc423902191]Test Risks / Issues
 [Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]
[bookmark: _Toc423902192]Items to be Tested / Not Tested
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]
	Item to Test
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc423902193]Test Approach(s)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
[bookmark: _Toc423902194]Test Regulatory / Mandate Criteria
[Describe any regulations or mandates that the system must be tested against.]
[bookmark: _Toc423902195]Test Pass / Fail Criteria
[Describe the criteria used to determine if a test item has passed or failed its test.]
[bookmark: _Toc423902196]Test Entry / Exit Criteria
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]
[bookmark: _Toc423902197]Test Deliverables
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]
[bookmark: _Toc423902198]Test Suspension / Resumption Criteria
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]
[bookmark: _Toc423902199]Test Environmental / Staffing / Training Needs
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc).)]
[bookmark: _Toc423902200]IN PROCESS Testing
In process testing is a practical approach to finding and containing defects where and when they occur within the build process.
[bookmark: _Toc423902201]Test Risks / Issues
 [Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]
[bookmark: _Toc423902202]Items to be Tested / Not Tested
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]
	Item to Test
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc423902203]Test Approach(s)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
[bookmark: _Toc423902204]Test Regulatory / Mandate Criteria
[Describe any regulations or mandates that the system must be tested against.]
[bookmark: _Toc423902205]Test Pass / Fail Criteria
[Describe the criteria used to determine if a test item has passed or failed its test.]
[bookmark: _Toc423902206]Test Entry / Exit Criteria
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]
[bookmark: _Toc423902207]Test Deliverables
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]
[bookmark: _Toc423902208]Test Suspension / Resumption Criteria
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]
[bookmark: _Toc423902209]Test Environmental / Staffing / Training Needs
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc).)]
[bookmark: _Toc423902210]END-OF-LINE Testing
End-of-line testing involves ensuring that that integrated components of an application function as expected. The entire application is tested in a real-world scenario such as communicating with the database, network, hardware and other applications.
[bookmark: _Toc423902211]Test Risks / Issues
 [Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]
[bookmark: _Toc423902212]Items to be Tested / Not Tested
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]
	Item to Test
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc423902213]Test Approach(s)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
[bookmark: _Toc423902214]Test Regulatory / Mandate Criteria
[Describe any regulations or mandates that the system must be tested against.]
[bookmark: _Toc423902215]Test Pass / Fail Criteria
[Describe the criteria used to determine if a test item has passed or failed its test.]
[bookmark: _Toc423902216]Test Entry / Exit Criteria
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]
[bookmark: _Toc423902217]Test Deliverables
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]
[bookmark: _Toc423902218]Test Suspension / Resumption Criteria
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]
[bookmark: _Toc423902219]Test Environmental / Staffing / Training Needs
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc).)]
[bookmark: _Toc423902220]Load Testing
Load testing is the process of putting demand on a system or device and measuring its response. Load testing is performed to determine a system’s behavior under both normal and anticipated peak load conditions.
[bookmark: _Toc423902221]Test Risks / Issues
 [Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]
[bookmark: _Toc423902222]Items to be Tested / Not Tested
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]
	Item to Test
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc423902223]Test Approach(s)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
[bookmark: _Toc423902224]Test Regulatory / Mandate Criteria
[Describe any regulations or mandates that the system must be tested against.]
[bookmark: _Toc423902225]Test Pass / Fail Criteria
[Describe the criteria used to determine if a test item has passed or failed its test.]
[bookmark: _Toc423902226]Test Entry / Exit Criteria
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]
[bookmark: _Toc423902227]Test Deliverables
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]
[bookmark: _Toc423902228]Test Suspension / Resumption Criteria
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]
[bookmark: _Toc423902229]Test Environmental / Staffing / Training Needs
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc).)]
[bookmark: _Toc423902230]Performance Testing
Covers a wide range of engineering or functional evaluations where a material, product, or system is not specified by detailed material or component specifications: rather, emphasis is on the final measurable performance characteristics. Testing can be a qualitative or quantitative procedure.
[bookmark: _Toc423902231]Test Risks / Issues
 [Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]
[bookmark: _Toc423902232]Items to be Tested / Not Tested
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]
	Item to Test
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc423902233]Test Approach(s)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
[bookmark: _Toc423902234]Test Regulatory / Mandate Criteria
[Describe any regulations or mandates that the system must be tested against.]
[bookmark: _Toc423902235]Test Pass / Fail Criteria
[Describe the criteria used to determine if a test item has passed or failed its test.]
[bookmark: _Toc423902236]Test Entry / Exit Criteria
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]
[bookmark: _Toc423902237]Test Deliverables
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]
[bookmark: _Toc423902238]Test Suspension / Resumption Criteria
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]
[bookmark: _Toc423902239]Test Environmental / Staffing / Training Needs
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc).)]
[bookmark: _Toc423902240]Regression Testing
Regression testing is a type of software testing that seeks to uncover new software bugs, or regressions, in existing functional and non-functional areas of a system after changes such as enhancements, patches or configuration changes, have been made to them.
The purpose of regression testing is to ensure that changes such as those mentioned above have not introduced new faults. One of the main reasons for regression testing is to determine whether a change in one part of the software affects other parts of the software.
[bookmark: _Toc423902241]Test Risks / Issues
 [Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]
[bookmark: _Toc423902242]Items to be Tested / Not Tested
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]
	Item to Test
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc423902243]Test Approach(s)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
[bookmark: _Toc423902244]Test Regulatory / Mandate Criteria
[Describe any regulations or mandates that the system must be tested against.]
[bookmark: _Toc423902245]Test Pass / Fail Criteria
[Describe the criteria used to determine if a test item has passed or failed its test.]
[bookmark: _Toc423902246]Test Entry / Exit Criteria
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]
[bookmark: _Toc423902247]Test Deliverables
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]
[bookmark: _Toc423902248]Test Suspension / Resumption Criteria
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]
[bookmark: _Toc423902249]Test Environmental / Staffing / Training Needs
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc).)]
[bookmark: _Toc423902250]Stress Testing
Stress testing involves testing beyond normal operational capacity, often to a breaking point, in order to observe the results.
[bookmark: _Toc423902251]Test Risks / Issues
 [Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]
[bookmark: _Toc423902252]Items to be Tested / Not Tested
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]
	Item to Test
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc423902253]Test Approach(s)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
[bookmark: _Toc423902254]Test Regulatory / Mandate Criteria
[Describe any regulations or mandates that the system must be tested against.]
[bookmark: _Toc423902255]Test Pass / Fail Criteria
[Describe the criteria used to determine if a test item has passed or failed its test.]
[bookmark: _Toc423902256]Test Entry / Exit Criteria
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]
[bookmark: _Toc423902257]Test Deliverables
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]
[bookmark: _Toc423902258]Test Suspension / Resumption Criteria
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]
[bookmark: _Toc423902259]Test Environmental / Staffing / Training Needs
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc).)]
[bookmark: _Toc423902260]System Testing
System testing of software or hardware is testing conducted on a complete, integrated system to evaluate the system's compliance with its specified requirements.
[bookmark: _Toc423902261]Test Risks / Issues
 [Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]
[bookmark: _Toc423902262]Items to be Tested / Not Tested
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]
	Item to Test
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc423902263]Test Approach(s)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
[bookmark: _Toc423902264]Test Regulatory / Mandate Criteria
[Describe any regulations or mandates that the system must be tested against.]
[bookmark: _Toc423902265]Test Pass / Fail Criteria
[Describe the criteria used to determine if a test item has passed or failed its test.]
[bookmark: _Toc423902266]Test Entry / Exit Criteria
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]
[bookmark: _Toc423902267]Test Deliverables
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]
[bookmark: _Toc423902268]Test Suspension / Resumption Criteria
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]
[bookmark: _Toc423902269]Test Environmental / Staffing / Training Needs
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc).)]
[bookmark: _Toc423902270]Unit Testing
A unit test is an automated piece of code that invokes a unit of work in the system and then checks a single assumption about the behavior of that unit of work
[bookmark: _Toc423902271]Test Risks / Issues
 [Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]
[bookmark: _Toc423902272]Items to be Tested / Not Tested
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]
	Item to Test
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc423902273]Test Approach(s)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
[bookmark: _Toc423902274]Test Regulatory / Mandate Criteria
[Describe any regulations or mandates that the system must be tested against.]
[bookmark: _Toc423902275]Test Pass / Fail Criteria
[Describe the criteria used to determine if a test item has passed or failed its test.]
[bookmark: _Toc423902276]Test Entry / Exit Criteria
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]
[bookmark: _Toc423902277]Test Deliverables
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]
[bookmark: _Toc423902278]Test Suspension / Resumption Criteria
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]
[bookmark: _Toc423902279]Test Environmental / Staffing / Training Needs
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc).)]
[bookmark: _Toc423902280]User Acceptance Testing
[bookmark: _GoBack]In engineering and its various sub-disciplines, acceptance testing is a test conducted to determine if the requirements of a specification or contract are met. It may involve chemical tests, physical tests, or performance tests.
[bookmark: _Toc423902281]Test Risks / Issues
 [Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]
[bookmark: _Toc423902282]Items to be Tested / Not Tested
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]
	Item to Test
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: _Toc423902283]Test Approach(s)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
[bookmark: _Toc423902284]Test Regulatory / Mandate Criteria
[Describe any regulations or mandates that the system must be tested against.]
[bookmark: _Toc423902285]Test Pass / Fail Criteria
[Describe the criteria used to determine if a test item has passed or failed its test.]
[bookmark: _Toc423902286]Test Entry / Exit Criteria
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]
[bookmark: _Toc423902287]Test Deliverables
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]
[bookmark: _Toc423902288]Test Suspension / Resumption Criteria
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]
[bookmark: _Toc423902289]Test Environmental / Staffing / Training Needs
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc).)]


Test Plan Approval
The undersigned acknowledge they have reviewed the <Project Name> Test Plan document and agree with the approach it presents. Any changes to this Requirements Definition will be coordinated with and approved by the undersigned or their designated representatives.
[List the individuals whose signatures are required.  Examples of such individuals are Business Manager, Technical Manager, and Project Manager. Add additional signature lines as necessary.]
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[bookmark: _Toc423902291]
Appendix A: References
[Insert the name, version number, description, and physical location of any documents referenced in this document.  Add rows to the table as necessary.] 
The following table summarizes the documents referenced in this document.
	Document Name and Version
	Description
	Location

	<Document Name and Version Number>
	[Provide description of the document]
	<URL or Network path where document is located>



[bookmark: _Toc423902292]
Appendix B: Key Terms
[Insert terms and definitions used in this document.  Add rows to the table as necessary. Follow the link below to for definitions of project management terms and acronyms used in this and other documents.
The following table provides definitions for terms relevant to this document.
	Term
	Definition

	[Insert Term]
	[Provide definition of the term used in this document.]

	[Insert Term]
	[Provide definition of the term used in this document.]

	[Insert Term]
	[Provide definition of the term used in this document.]
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